
OSSSC CRE 2025
Combined Recruitment Examination · Preliminary · Question Paper

23 May 2026 · 12:30 PM - 2:00 PM English Version

RI · ICDS Supervisor · VAW · JA · ARI · Amin · SFS  |  Official Answer Key

About this Paper

This is the OSSSC Combined Recruitment Examination (CRE) 2025 Preliminary written test (Advt. IIE-120/2025-3219) for the posts of
Revenue Inspector, ICDS Supervisor, Village Agricultural Worker, Junior Assistant, Assistant Revenue Inspector, Amin & Statistical Field
Surveyor — 23 May 2026, 12:30 PM - 2:00 PM shift, English version, with the correct option marked as per the official answer key.

Exam pattern: 100 questions · 100 marks · 90 minutes. Sections: Mathematics 20, General Studies 20, English 20, Odia 15, Computer
15, Logical Reasoning 10. Marking: +1 correct, −0.25 wrong.

✓ Correct option (highlighted green)

More from QMaths

Check your marks & All-India rank at rank.qmaths.in. Master English vocabulary with the Blackbook app.

Toppers' Choice, Blackbook of English Vocabulary, Now available in App format : DOWNLOAD NOW

https://rank.qmaths.in/
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25


Paper Set 1 · 23 May 2026 · 12:30 PM - 2:00 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
Find out the surface area of largest possible cube inscribed in a
sphere of radius 5 cm.

A.  150 cm2

B.  100 cm2

C.  200 cm2

D.  250 cm2

✓

Q2 Quant
At a uniform speed, a car covers a distance in 9 hours. Had the
speed been increased by 8 km/hr, the same distance could have
been covered in
7 hours 30 minutes. What is the distance covered?

A.  360 km

B.  370 km

C.  380 km

D.  390 km

✓

Q3 Quant
Kundan starts a business with ₹40,000. After 6 months, Naresh joins
Kundan as his partner. At the end of the year, the profit is divided in
the ratio 5 : 7. What was Naresh's contribution to the capital?

A.  ₹1,12,000

B.  ₹1,14,000

C.  ₹1,16,000

D.  ₹1,18,000

✓

Q4 Quant
A and B enter into a partnership. A invests ₹20,000, and B invests
₹30,000. After 6 months, A invests an additional ₹10,000. If the total
profit at the end of the year is ₹44,000, what is B's share of the
profit?

A.  ₹24,000

B.  ₹26,000

C.  ₹28,000

D.  ₹36,000

✓

Q5 Quant
Solve the following linear equations.

x + y + z = 24, 2x − y − z = 18 and x − y − 2z = 16

A.  x = 14, y = 22, z = −12

B.  x = 12, y = 14, z = 22

C.  x = −12, y = −14, z = 22

D.  x = −14, y = −22, z = 12

✓

Q6 Quant

A person can mow a 126 m2 lawn in 6 minutes. How much area (in
m2) of the lawn will he mow in 4.5 hours?

A.  5670

B.  5695

C.  5760

D.  5784

✓

Q7 Quant
A desktop is marked at ₹52,500. If Anil buys it for ₹45,150, what
discount percentage did the dealer offer?

A.  12 %

B.  16 %

C.  17 %

D.  14 %

✓

Q8 Quant
An electrician and a plumber can finish a repair job together in 4
days. If the electrician alone takes 6 days, how many days will the
plumber alone take?

A.  12

B.  6

C.  4

D.  8
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✓

Q9 Quant
If the mean of a dataset is 10 and the median is 14.5, which of the
following can be the mode of the dataset?

A.  22.5

B.  23.5

C.  24.5

D.  21.5

✓

Q10 Quant
There are 30 boys and 70 girls in a class. If the average age of boys
is 10 years and the average age of girls is 12 years, then find the
average age (in years) of the whole class.

A.  10.6

B.  11.4

C.  12.6

D.  13.4

✓

Q11 Quant
One pipe can fill a tank in 8 minutes while another pipe can empty
the completely filled tank in 16 minutes. If both the pipes are
opened together when the tank is empty, how many minutes will it
take to fill three-fourths of the tank?

A.  12

B.  24

C.  13

D.  25

✓

Q12 Quant
The profit made on a product is 60%. What is the loss percentage
incurred on the sale if the figures of both cost price and selling price
are interchanged?3182

A.  37.5%

B.  39.19%

C.  36.95%

D.  37.12%

✓

Q13 Quant
What will be the amount after 1 year, if ₹5,600 is invested at 20%
compound interest per annum, compounded half-yearly?9792

A.  ₹6,776

B.  ₹5,876

C.  ₹7,459

D.  ₹6,408

✓

Q14 Quant
A solid metallic sphere of radius 14 cm is melted to form 125 small
solid spheres. What is the surface area (in sq. cm) of all the new
spheres? (Use π = 22/7)

A.  12230

B.  14350

C.  14530

D.  12320

✓

Q15 Quant
A person invested ₹50,000 in a scheme. After the first year, the value
of the investment increased by 12%. In the second year, the value
decreased by 8%. What is the final value of the investment after 2
years?

A.  ₹53,600

B.  ₹54,600

C.  ₹51,520

D.  ₹53,620

✓

Q16 Quant

A person’s income and expenditure are in the ratio 5 : 4. If the
income increases by 20% and the expenditure increases by 10%, find
the final savings as a percentage of the initial income of ₹60,000.

A.  10%

B.  15%

C.  28%

D.  32%

✓

Q17 Quant
Let AP and BQ be two towers such that A and B are the feet of the
towers, respectively. Let C be the midpoint of AB. From point C, the
angle of elevation of the tops P and Q of the towers are 30° and 60°,
respectively. Find the ratio of the height of the tower AP to that of
tower BQ.

A.  3 : 1

B.  1 : 2

C.  1 : 3

D.  2 : 1
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✓

Q18 Quant
A motorboat travels a distance of 48 kilometres downstream in a river and returns to the starting point. The river has a current speed of 4
km/hr. The boat's speed in still water is x km/hr. Determine the average speed of the boat.

A.  

B.  

C.  

D.  

✓

Q19 Quant

A.  13

B.  15

C.  17

D.  19

✓

Q20 Quant
MCQ

A.  

B.  

C.  

D.  
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GA

✓

Q21 GA
Who among the following was named as the brand ambassador of
L&T Finance Ltd. in March 2025?

A.  Jasprit Bumrah

B.  Virat Kohli

C.  Rohit Sharma

D.  Rishabh Pant

✓

Q22 GA
Which of the following is the scheme connecting top candidates of
Union Public Service Commission with Private Employers?

A.  Gyan Deep

B.  Prathibha Setu

C.  Shiksha Sarathi

D.  Vidya Vahini

✓

Q23 GA
Which sector in 19th-century Odisha was severely impacted by the
competition from British imported goods?

A.  Salt and Sugar Industry

B.  Handloom weaving and textile industry

C.  Brass and bell-metal industry

D.  Rice milling industry

✓

Q24 GA
In which year did the Odisha State Road Transport Corporation
(OSRTC) begin its operations?

A.  1974

B.  1976

C.  1985

D.  1988

✓

Q25 GA
When mapping the magnetic field around a solenoid, the field lines
inside are observed to be parallel straight lines. What does this
geometrical feature fundamentally indicate about the magnetic field
within the solenoid's interior?

A.  The field is non-uniform and strongest at the center.

B.  The field is uniform, possessing the same magnitude and
direction everywhere inside.

C.  The field strength decreases linearly from one end to the
other.

D.  The field lines, being parallel, are incapable of forming closed
loops.

✓

Q26 GA
In March 2026, Union Home Minister Amit Shah inaugurated the
Sulphuric Acid Plant–III (SAP-III) at which place in Odisha?

A.  Bhubaneswar

B.  Rourkela

C.  Paradip

D.  Cuttack

✓

Q27 GA
Which state's pavilion won “Best Stall” at India Maritime Week 2025
(Mumbai)?

A.  Gujarat

B.  Odisha

C.  Maharashtra

D.  Tamil Nadu

✓

Q28 GA
Which of the following is cited as a 'natural' factor contributing to
India's disaster proneness?

A.  Industrialization

B.  Adverse geo climatic conditions

C.  Urbanisation

D.  Non scientific development practices
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✓

Q29 GA
Which of the following reformers founded the Widow Marriage
Association in 1860?

A.  Pandit Vishnu Shastri

B.  Jyotiba Phule

C.  M.G. Ranade

D.  Rammohan Roy

✓

Q30 GA
Which of the following countries topped the medal tally at the 24th
Asian Archery Championships 2025?

A.  China

B.  Japan

C.  India

D.  South Korea

✓

Q31 GA
Which city hosted the International Tennis Federation Davis Cup
Finals in November 2025?

A.  Bologna

B.  Madrid

C.  Vienna

D.  Rome

✓

Q32 GA
In the context of the four pillars of human development, which term
refers to providing every individual with equal access to
opportunities regardless of their gender, race, or income?

A.  Sustainability

B.  Empowerment

C.  Productivity

D.  Equity

✓

Q33 GA
Which practice helps reduce water pollution from fertilizers?

A.  Applying fertilizers in recommended amounts

B.  Applying fertilizers during heavy rain

C.  Using fertilizers at random times

D.  Doubling the fertilizer dose

✓

Q34 GA
Which of the following types of mass movement involves the
slipping of one or several units of rock debris with a backward
rotation with respect to the slope over which the movement takes
place?

A.  Deposition

B.  Creep

C.  Erosion

D.  Slump

✓

Q35 GA
Which physical feature is most commonly associated with steep
slopes, multiple channels that diverge and rejoin, and variable
discharge, typically found near the snout of a glacier?

A.  Braided stream

B.  Delta distributary

C.  Meandering river

D.  Oxbow lake

✓

Q36 GA
In context to Indian music and dance, which one of the following
classical dance forms originated in the state of Tamil Nadu and is
known for its fixed upper torso, bent legs, and expressive hand
gestures (mudras)?

A.  Kathak

B.  Kathakali

C.  Manipuri

D.  Bharatnatyam

✓

Q37 GA
Which Amendment removed the 50% ceiling on reservation in
backlog vacancies?

A.  79th

B.  80th

C.  81st

D.  82nd

✓

Q38 GA
Which premier Indian institute took the initiative to introduce the
sport OmegaBall in India for the first time?

A.  Indian Institute of Technology Bombay

B.  Indian Institute of Technology Delhi

C.  Indian Institute of Technology Madras

D.  Indian Institute of Technology Kanpur
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✓

Q39 GA
What is the term for the amount of solute dissolved in a given mass
or volume of solvent?

A.  Solubility

B.  Dilution

C.  Concentration

D.  Miscibility

✓

Q40 GA
Which of the following contains the Andaman and Nicobar Islands?

A.  Arabian Sea

B.  Pacific Ocean

C.  Bay of Bengal

D.  Red Sea

English

✓

Q41 English
Select the appropriate option to complete the sentence.
The ____ athlete set a new world record in the marathon.1543

A.  lazy

B.  clumsy

C.  fair

D.  swift

✓

Q42 English
Select the option that can be used as a one-word substitute for the underlined group of words.

Mira wrote a heartfelt letter to her parents, earnestly pleading with them to understand her perspective and support her decision to pursue a
career in the arts.

A.  enjoining

B.  encamping

C.  entreating

D.  entailing
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✓

Q43 English
Sentences of a paragraph are given below in jumbled order. Arrange the sentences in the correct order to form a meaningful and coherent
paragraph.

A. This innovation significantly improved the efficiency of early industrial machines.
B. James Watt’s invention of the steam engine revolutionized transportation and industry.
C. As a result, factories could operate with greater productivity, leading to economic growth.
D. The use of steam engines spread rapidly across Europe and America.

A.  B - A - C - D

B.  A - B - D - C

C.  B - D - A - C

D.  D - B - A - C

✓

Q44 English
Replace the highlighted phrase with a suitable idiom.
Despite facing criticism from all sides, the scientist remained determined and focused on her research.

A.  threw in the towel

B.  beat around the bush

C.  kept her eyes on the ball

D.  cried over spilt milk

✓

Q45 English
Choose the most appropriate antonym of the underlined word.
She had a unique ability to cajole people into helping her, even when her requests were anything but simple.

A.  coax

B.  quit

C.  beguile

D.  intimidate

✓

Q46 English
Select the most appropriate idiom that means the same as the capitalised words in the sentence below.

The journalist was determined TO MAKE SOMETHING KNOWN THAT WAS HIDDEN from the public.

A.  to blow one’s trumpet

B.  to beat around the bush

C.  to bring to light

D.  to call it a day

✓

Q47 English
Choose the sentence that is correctly written in Indirect Speech.

A.  The lawyer said that “the case is strong.”

B.  The lawyer said that the case was strong.

C.  The lawyer said, the case was strong.

D.  The lawyer said that the case is strong.
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✓

Q48 English
Choose the correct Passive Voice form of the following sentence.
The students clean the classroom every day.

A.  The classroom is cleaned by the students every day.

B.  The classroom was cleaned by the students every day.

C.  The students were cleaning the classroom every day.

D.  The students are being cleaned by the classroom every day.

✓

Q49 English

Read the given passage and answer the questions that follow.

Mobile phones have become an essential part of teenagers’ lives in the modern world. They are used not only for communication but also for
education, entertainment, and social interaction. With access to the internet, teenagers can gather information quickly and stay connected with
friends and family. However, excessive use of mobile phones can have negative effects. Many teenagers spend long hours on social media or
playing games, which may reduce their focus on studies and physical activities. It can also affect sleep patterns, as late-night screen use is
common. In some cases, overdependence on mobile phones may lead to reduced face-to-face communication and social skills. Despite these
concerns, mobile phones can be beneficial when used wisely. They provide learning opportunities, access to educational content, and tools for
creativity. Therefore, maintaining a balance between usage and other activities is important for the healthy development of teenagers.

What is the main idea of the passage?

A.  Development of communication technology

B.  Growth of internet usage worldwide

C.  Impact of mobile phones on teenagers

D.  Influence of games on children

✓

Q50 English
How can mobile phone use affect sleep?

A.  It reduces tiredness.

B.  It improves alertness.

C.  It disrupts sleep patterns.

D.  It improves sleep quality.

✓

Q51 English
Select the most appropriate antonym of 'beneficial'.

A.  helpful

B.  effective

C.  supportive

D.  harmful
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✓

Q52 English
What benefit of mobile phones is highlighted in the passage?

A.  They reduce the need for communication tools.

B.  They strengthen face-to-face interaction.

C.  They reduce dependence on technology.

D.  They provide quick access to information.

✓

Q53 English
What can be inferred about teenagers’ phone usage?

A.  It may become difficult to regulate usage.

B.  It improves balance in daily activities.

C.  It reduces dependence on other digital tools.

D.  It is limited mainly to educational use.

✓

Q54 English
Choose the sentence which is correctly written in Present Tense.

A.  The train has been arrive at the station on time.

B.  The train regularly arrives at the station on time.

C.  The train is arrived at the station now.

D.  The train is arrive at the station.

✓

Q55 English
Choose the correct word from given options for the underlined group of words in the sentence.
The principal warned that any student caught in doing that is against the rules activity would be suspended.

A.  adaptable

B.  fraudulent

C.  charismatic

D.  apathetic

✓

Q56 English
Identify the INCORRECTLY spelt word in the given sentence and select the option that rectifies it.

Their collaborative approach proved highly eficient under pressure.

A.  colaborative

B.  appraoch

C.  efficient

D.  pressurre
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✓

Q57 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

A) president
B) Rajendra Prasad
C) of India
D) was the first

A.  BDAC

B.  ACBD

C.  ABCD

D.  CBDA

✓

Q58 English
Select the most appropriate article to fill in the blank. If no article is required, select ‘No article required’.

I went to ___ doctor who treated me last year in Delhi AIIMS.

A.  a

B.  an

C.  the

D.  No article required

✓

Q59 English
Select the most appropriate option to fill in the blank.

Robbin _____ football for the Mohan Baghan club every year.

A.  played

B.  playing

C.  plays

D.  play

✓

Q60 English
Select the most appropriate ANTONYM of the highlighted word in the given sentence.

The forest fire was quickly localised, preventing it from spreading to nearby villages.

A.  Controlled

B.  Reduced

C.  Expanded

D.  Limited
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Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ସୌର ଜଗତରେ ଆଠଟି  ଗ୍ର ହ ରହି ଅଛି  ।

A.  There are eight planets in the solar system.

B.  There is eight planet in solar system.

C.  There have eight planets in solar system.

D.  Solar system having eight planets.

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ମାଛଧରା ଅନେକ ତଟୀୟ ସମୁ ଦାୟଙ୍କର ସାମୁ ଦ୍ରି  କ ଅର୍ଥ ନୀତି  ପାଇଁ  ଏକ ମହତ୍ୱପୂ ର୍ଣ୍ଣ  ଅଂଶ ଅଟେ ।

A.  Fishing is an important part of the marine economy for many coastal communities.

B.  Fishing is important part of marine economy for many coastal community.

C.  Fishing are an important part of the marine economy for many coastal communities.

D.  Fishing is an important part of marine economy for many coastal communities.

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
Virat Kohli is a great batsman of the Indian team.

A.  ବି ରାଟ କୋହଲି  ଭାରତୀୟ ଦଳର ଜଣେ ମହାନ ବ୍ୟାଟ୍ସ ମାନ ଅଟନ୍ତି ।

B.  ବି ରାଟ କୋହଲି  ଭାରତୀୟ ଟି ମ୍ ‌ର ଏକ ଶ୍ରେ ଷ୍ଠ ବ୍ୟାଟ୍ସ ମ୍ୟାନ୍  ଅଛି ।

C.  ବି ରାଟ କୋହଲି  ଭାରତୀୟ ଟି ମ୍ ‌ର ଏକ ଶ୍ରେ ଷ୍ଠ ବ୍ୟାଟ୍ସ ମ୍ୟାନ୍  ଥି ଲା।

D.  ବି ରାଟ କୋହଲି  ଭାରତୀୟ ଟି ମ୍ ‌ର ଏକ ଶ୍ରେ ଷ୍ଠ ବ୍ୟାଟ୍ସ ମ୍ୟାନ୍  ଅଛନ୍ତି ।

✓

Q64 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ |

"ଭାରତର ଚାଉଳ ପାତ୍ର " ଶବ୍ଦଟି  ସାଧାରଣତଃ ଆନ୍ଧ୍ର ପ୍ର ଦେଶ ରାଜ୍ୟ ସହି ତ ଜଡି ତ, ଏହାର ବି ଶାଳ ଉର୍ବ ର ସମତଳ ଭୂ ମି , ପ୍ର ଚୁ ର ଜଳ ସମ୍ପଦ ଏବଂ ଉଚ୍ଚ ଧାନ ଉତ୍ପାଦନ ହେତୁ  ଏହି  ରାଜ୍ୟକୁ  ଏହି
ଆଖ୍ୟା ଦି ଆଯାଏ । ରାଜ୍ୟର ଉପକୂ ଳବର୍ତ୍ତୀ  ଅଞ୍ଚଳରେ ଅବସ୍ଥି ତ କୃ ଷ୍ଣା -ଗୋଦାବରୀ ଡେଲ୍ଟା  ଆନ୍ଧ୍ର ପ୍ର ଦେଶକୁ  ଏକ ପ୍ର ମୁ ଖ ଧାନ ଉତ୍ପାଦନକାରୀ ଅଞ୍ଚଳ କରି ବାରେ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଭୂ ମି କା ଗ୍ର ହଣ କରେ କୃ ଷ୍ଣା
ଏବଂ ଗୋଦାବରୀ ନଦୀର ପଙ୍କ ଜମା ଦ୍ୱାରା ସମୃ ଦ୍ଧ ଡେଲ୍ଟା ଏକ ସମତଳ ଭୂ ମି  ଉର୍ବ ର କୃ ଷି  ଭୂ ମି  ସୃ ଷ୍ଟି  କରେ, ଯାହା ଧାନ ଚାଷ ପାଇଁ  ଅତ୍ୟନ୍ତ ଉପଯୁ କ୍ତ । ଏହି  ଅଞ୍ଚଳର ଏକ ଦୀର୍ଘ  କୃ ଷି  ଇତି ହାସ ରହି ଛି  ,
ଏବଂ ବ୍ରି  ଟି ଶ ସମୟରେ ନି ର୍ମିତ କେନାଲ ଭଳି  ଉନ୍ନତ ଜଳସେଚନ ସୁ ବି ଧା, ଆଧୁ ନି କ ଉଠା-ଜଳସେଚନ ପ୍ର କଳ୍ପ ସହି ତ, ଉତ୍ପାଦନ ବୃ ଦ୍ଧି  କରି ଛି । ଏହି  ରାଜ୍ୟ ଉପଯୁ କ୍ତ ଜଳବାୟୁ  ପରି ସ୍ଥି ତି  ଏବଂ ଏକ
ପରି ଶ୍ର ମୀ ଚାଷୀ ସମ୍ପ୍ରଦାୟ ଦ୍ୱାରା ସମର୍ଥିତ ଖରି ଫ ଏବଂ ରବି  ଋତୁ ରେ ଉଚ୍ଚ ଉତ୍ପାଦନ ରେକର୍ଡ  କରି ଛି । ଏହା ସହି ତ, ଉନ୍ନତ ବି ହନ, ଯାନ୍ତ୍ରି କୀକରଣ ଏବଂ ସର୍ବ ନି ମ୍ନ  ସହାୟକ ମୂ ଲ୍ୟ ମାଧ୍ୟମରେ
ସରକାରୀ ସମର୍ଥ ନ ଏହି  ଅଞ୍ଚଳର କୃ ଷି  ଅର୍ଥ ନୀତି କୁ  ସୁ ଦୃ ଢ଼ ​​କରି ଛି  । ଯଦି ଓ ଆନ୍ଧ୍ର ପ୍ର ଦେଶକୁ  ଏହି  ଉପାଧି  ଦି ଆଯାଇଛି , ଛତି ଶଗଡ଼କୁ  ମଧ୍ୟ ପ୍ରା ୟତଃ "ଭାରତର ଧାନ ପାତ୍ର " ବୋଲି  କୁ ହାଯାଏ କାରଣ
ପାରମ୍ପରି କ ଧାନ ଚାଷରେ ଏହାର ପ୍ରା ଧାନ୍ୟ ଏବଂ ଏହାର ପ୍ରା ୟ 70% ଚାଷଯୋଗ୍ୟ ଜମି ରେ ଧାନ ଚାଷ କରାଯାଏ । ତାମି ଲନାଡୁ , ପଶ୍ଚି ମବଙ୍ଗ ଏବଂ ଓଡ଼ି ଶାର ସମୃ ଦ୍ଧ ଅଞ୍ଚଳ ଗୁ ଡ଼ି କ ମଧ୍ୟ ଧାନ
ଉତ୍ପାଦକ ରେ ପରି ପୂ ର୍ଣ୍ଣ  । ତେବେ ବୃ ହତ ପରି ମାଣର ଉତ୍ପାଦନ, ରପ୍ତାନି  କ୍ଷମତା ଏବଂ ଦେଶର ଖାଦ୍ୟ ସୁ ରକ୍ଷାରେ କୃ ଷ୍ଣା-ଗୋଦାବରୀ ଅଞ୍ଚଳ ଯେଉଁ  ପ୍ର ମୁ ଖ ଭୂ ମି କା ଗ୍ର ହଣ କରେ, ତାହା ଆନ୍ଧ୍ର ପ୍ର ଦେଶକୁ
ଏହି  ସମ୍ମାନରେ ବ୍ୟାପକ ଭାବରେ ସ୍ୱୀକୃ ତି  ପ୍ର ଦାନ କରି ବାରେ ସହାୟକ ହୋଇଥାଏ । ଧାନ ଚାଷ ରାଜ୍ୟର ଲୋକଙ୍କ ସଂସ୍କୃତି , ପର୍ବ  ଏବଂ ଜୀବି କାରେ ଗଭୀର ଭାବରେ ଜଡି ତ, ଏବଂ ଚାଉଳ ଦୈ ନନ୍ଦି ନ
ଖାଦ୍ୟ ଏବଂ ଉତ୍ସବଗତ ଅବସର ଉଭୟର ଏକ କେନ୍ଦ୍ରୀୟ ଉପାଦାନ ହୋଇ ରହି ଛି । ଆଧୁ ନି କୀକରଣ, ପୋଲାଭରମ୍  ପ୍ର କଳ୍ପ ପରି  ଉନ୍ନତ ଜଳସେଚନ ନେଟୱାର୍କ  ଏବଂ କୃ ଷି  ଗବେଷଣା ସୁ ବି ଧା ସହି ତ,
ଆନ୍ଧ୍ର ପ୍ର ଦେଶର ଧାନ ଚାଷକାରୀ ଅଞ୍ଚଳ ଗୁ ଡ଼ି କ ସମୃ ଦ୍ଧ ହେବାରେ ଲାଗି ଛି , ଯାହା ଭାରତର ପ୍ର କୃ ତ ଚାଉଳ ପାତ୍ର  ଭାବରେ ରାଜ୍ୟର ଖ୍ୟାତି କୁ  ସୁ ଦୃ ଢ଼ ​​କରୁ ଛି ।

କେଉଁ  ରାଜ୍ୟ "ଭାରତର ଚାଉଳ ପାତ୍ର " ଭାବରେ ସାଧାରଣତଃ ଜଣାଶୁ ଣା ?

A.  ପଞ୍ଜାବ

B.  ଆନ୍ଧ୍ର ପ୍ର ଦେଶ

C.  ଗୁ ଜୁ ରାଟ

D.  ରାଜସ୍ଥାନ
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✓

Q65 Odia
କୃ ଷ୍ଣା -ଗୋଦାବରୀ ଡେଲ୍ଟା  କେଉଁ  ରାଜ୍ୟରେ ଅବସ୍ଥି ତ?

A.  କର୍ଣ୍ଣା ଟକ

B.  ଆନ୍ଧ୍ର ପ୍ର ଦେଶ

C.  ବି ହାର

D.  ତାମି ଲନାଡୁ

✓

Q66 Odia
ଆନ୍ଧ୍ର ପ୍ର ଦେଶରେ ଜଳସେଚନ ପାଇଁ  କେଉଁ  ପ୍ର କଳ୍ପର ଯୋଗଦାନ ରହି ଛି  ?

A.  ତେହରୀ

B.  ପୋଲାଭରମ୍

C.  ଭାକ୍ରା  ନାଙ୍ଗଲ୍

D.  ସର୍ଦ୍ଦା ର ସରୋବର

✓

Q67 Odia
ଛତି ଶଗଡ଼କୁ  ମଧ୍ୟ କାହିଁକି  ଚାଉଳ ପାତ୍ର  କୁ ହାଯାଏ ?

A.  ଏହାର ବି ଶାଳ ହ୍ର ଦ ଅଛି

B.  ରାଜ୍ୟର 70% ଚାଷଯୋଗ୍ୟ ଜମି ରେ ଧାନ ଚାଷ ହୁ ଏ

C.  ଏହା କେବଳ ଗହମ ଚାଷ କରେ

D.  ଏହା ଚି ନି  ରପ୍ତାନି  କରେ

✓

Q68 Odia
ଆନ୍ଧ୍ରପ୍ର ଦେଶ ରେ ଧାନ ଚାଷକୁ  ସହାୟକ ହେଉଥି ବା ମୁ ଖ୍ୟ ନଦୀଗୁ ଡ଼ି କ କେଉଁ ଟି  ?

A.  ଗଙ୍ଗା ଏବଂ ଯମୁ ନା

B.  କୃ ଷ୍ଣା ଏବଂ ଗୋଦାବରୀ

C.  ନର୍ମ ଦା ଏବଂ ତାପି

D.  ଚେନାବ ଏବଂ ଝେଲମ୍

✓

Q69 Odia
“ଅତି  ପରି ଚୟ ଗୌରବ ନଷ୍ଟ” - ଏହି  ଲୋକୋକ୍ତି ର ଅର୍ଥ  ଲେଖ ।

A.  ଅତି  ଗର୍ବ ରୁ  ବି ନାଶ

B.  ନି ଜ ଲୋକର ଶତ୍ରୁ ତା ଆଚରଣ

C.  ଅଜଣା କାମ କରି ନପାରି ବା

D.  ଅତ୍ୟଧି କ ମି ଳାମି ଶା ସମ୍ମାନ ହାନି  କାରକ

✓

Q70 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ତଦ୍ଭବ ଶବ୍ଦ ?

A.  ବାପା

B.  ବାମ

C.  ବର

D.  ବରା
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✓

Q71 Odia
ସଠି କ୍  ବନାନ୍  ଥି ବା ବାକ୍ୟଟି  ଚି ହ୍ନଟ କର ।

A.  ଲି ଫ୍ଟ ରେ ଯି ବା ଆସି ବା ସମୟରେ ଧୂ ମ୍ର ପାନ କରି ବା ଉଚି ତ୍  ନୁ ହେଁ  ।

B.  ଲି ଫ୍ଟ ରେ ଯି ବା ଆସି ବା ସମୟରେ ଧୂ ମପାନ କରି ବା ଉଚି ତ୍  ନୁ ହେଁ  ।

C.  ଲି ଫ୍ଟ ରେ ଯି ବା ଆସି ବା ସମୟରେ ଧୁ ମ୍ର ପାନ କରି ବା ଉଚି ତ୍  ନୁ ହେଁ  ।

D.  ଲି ଫ୍ଟ ରେ ଧୁ ମପାନ କରି ବା ଉଚି ତ୍  ନୁ ହେଁ  ଯି ବା ଆସି ବା ସମୟରେ ।

✓

Q72 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  ଶବ୍ଦାନୁ କାରୀ ଅବ୍ୟୟ କେଉଁ ଟି  ?

A.  ମନ୍ଦମନ୍ଦ

B.  ଧୋଧୋ

C.  ଥରକୁ ଥର

D.  ଡକାହକା

✓

Q73 Odia
ତୁ ମେ ବେତୁ ଲି ଏ ଉଖୁ ଡା ଆଣି ବ । ଏହି  ବାକ୍ୟରେ ପରି ମାଣବାଚକ ବି ଶେଷଣ କେଉଁ ଟି  ?

A.  ତୁ ମେ

B.  ବେତୁ ଲି ଏ

C.  ଉଖୁ ଡା

D.  ଆଣି ବ

✓

Q74 Odia
ଏହି କ୍ଷଣି  ମୁଁ  କଟକରୁ  ଆସି  ଘରେ ପହଞ୍ଚି ଲି  । ଏହି  ବାକ୍ୟରେ ବ୍ୟବହୃ ତ ସମୟସୂ ଚକ ଅବ୍ୟୟ କେଉଁ ଟି  ?

A.  ଏହି କ୍ଷଣି

B.  କଟକରୁ

C.  ମୁଁ

D.  ଘରେ

✓

Q75 Odia
"ଝି ଣ୍ଟି କା ମାରି  ବଣି  ପୋଷି ବା"- ଏହି  ରୂ ଢି ର ଅର୍ଥ  କ'ଣ ?

A.  ସବୁ କୁ  ସମାନ ଭାବେ ସାହାଯ୍ୟ କରି ବା

B.  ନି ଜ ପାଇଁ  କାମ କରି ବା

C.  ଦୁ ର୍ବ ଳକୁ  ସାହାଯ୍ୟ କରି ବା

D.  ଦୁ ର୍ବ ଳକୁ  ମାରି  ସବଳକୁ  ସାହାଯ୍ୟ କରି ବା
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Computer

✓

Q76 Computer
What does the Del key do?

A.  Copies text

B.  Inserts new text

C.  Deletes the character to the left of the cursor

D.  Deletes the character to the right of the cursor

✓

Q77 Computer
Which statement correctly describes Microsoft Office 2021 in the
historical evolution of Microsoft Office products?

A.  Office 2021 is the first web-only version of Office

B.  Office 2021 cannot open files created in earlier versions

C.  Office 2021 continues the desktop tradition with modern
Windows 11 integration

D.  Office 2021 removes all desktop features in favor of mobile
apps

✓

Q78 Computer
Which feature in Windows 11 allows users to quickly search for a file
or app directly from the Taskbar?

A.  Start Menu Widgets

B.  Windows Search Box

C.  File Explorer View Tab

D.  Run Dialog Box

✓

Q79 Computer
Which key in MS Powerpoint 2021 allows you to edit text directly in a
selected text box without deleting it?

A.  F2

B.  F3

C.  Shift + F2

D.  F5

✓

Q80 Computer
Which key can you press to start editing the contents of a selected
cell in MS Excel?

A.  F2

B.  F4

C.  Ctrl+E

D.  Esc

✓

Q81 Computer
Regarding websites and the World Wide Web (WWW), which of the
following statements is TRUE?

A.  The World Wide Web and the Internet are exactly the same.

B.  A website is a collection of related web pages stored on a
local computer only.

C.  The World Wide Web is a service that runs on the Internet to
access hyperlinked documents using web browsers.

D.  Web browsers are used to create websites and upload them
to web servers.

✓

Q82 Computer
Which command in MS Word 2020 is used to open a previously
saved document?

A.  Open

B.  Save

C.  Print

D.  Close

✓

Q83 Computer
Which statement is true about the Presenter View?

A.  Presenter View requires multiple monitors to show notes
separately to the presenter.

B.  Presenter View is available even on a single monitor with no
extra settings.

C.  Presenter View automatically records slide timings.

D.  Presenter View removes all animations from slides.

✓

Q84 Computer
Which of the following is TRUE about application software, but NOT
TRUE about system software?

A.  It directly manages CPU and memory.

B.  It starts automatically when the computer is powered on.

C.  It is usually developed for a specific user requirement.

D.  It acts as an interface between hardware and user.
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✓

Q85 Computer
In MS Excel, If you want to sort a column of numerical data in
descending order, which sequence of actions should you perform?

A.  Select the column, go to the 'Home' tab, and click on 'Sort A
to Z'.

B.  Select the column, go to the 'Data' tab, and click on 'Sort
Largest to Smallest'.

C.  Highlight the data, right-click, and select 'Sort by Value'.

D.  Go to the 'Insert' tab, select 'Sort Data', and select
'Descending'.

✓

Q86 Computer
What is the main difference between the 'Save' and 'Save As'
commands in Microsoft Word?

A.  Save always creates a new file, while Save As overwrites the
existing file.

B.  Save updates the current file, Save As creates a new copy

C.  Save is used only for new documents, while Save As is used
only for existing documents.

D.  Save changes the file format, while Save As only updates the
content.

✓

Q87 Computer

What is the full form of ISP?

A.  Internet Service Program

B.  Internal Server Protocol

C.  Internet Storage Protocol

D.  Internet Service Provider

✓

Q88 Computer
In MS Word 2010, which of the following is a valid use case for ‘Save
As’ in collaboration environments?

A.  Backing up an original document before editing

B.  Deleting unused content

C.  Merging two documents

D.  Auto-correcting text

✓

Q89 Computer
A user types '1/2' into a cell expecting a fraction, but Excel converts it
into a date. What step should the user take to ensure it is stored as a
fraction?

A.  Press Enter twice.

B.  Type a space before the value.

C.  Format the cell as Fraction.

D.  Use the currency symbol.

✓

Q90 Computer
During a group assignment, students are asked to create a visually
appealing presentation quickly. Instead of starting from a blank
slide, which method should they select to speed up the design
process using pre-defined slide layouts and formatting?

A.  Open Slide Sorter to rearrange slides.

B.  Create a new presentation by selecting a ready-made
template.

C.  Use the Review tab to check spelling.

D.  Insert a blank slide and format each element manually.

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


Reasoning

✓

Q91 Reasoning
Seven people N, O, P, Q, R, S and T are sitting in a straight line, facing
the north. Q is sitting to the immediate left of R and to the
immediate right of P. O is sitting to the immediate right of N and to
the immediate left of P. Similarly, S is sitting to the immediate right
of R and to the immediate left of T. Who is sitting at the fourth
position from the extreme left end of the line?2249

A.  O

B.  P

C.  Q

D.  R

✓

Q92 Reasoning
Each of S, T, U, V, M, N and O has an exam on a different day of a
week starting from Monday and ending on Sunday of the same
week. Only two people have exam between S and O. Only two
people have exam between V and U. Only two people have exam
between M and U. No one has exam after M. N has exam on one of
the days before T. O has exam immediately after T.
Who has exam on Wednesday?

A.  S

B.  U

C.  V

D.  M

✓

Q93 Reasoning
There are 30 boys and 70 girls in a class. If the average age of boys
is 10 years and the average age of girls is 12 years, then find the
average age (in years) of the whole class.

A.  PI-RK-TV

B.  PI-RK-TU

C.  OI-RK-TU

D.  OI-RL-TU

✓

Q94 Reasoning
If ‘I’ stands for ‘+’, ‘J’ stands for ‘×’, ‘K’ stands for ‘÷’, and ‘L’ stands for
‘-’, what will come in place of the question mark ‘?’ in the following
equation?

52 L (10 K 2) J 7 I 18 K 3 = ?

A.  20

B.  23

C.  35

D.  14

✓

Q95 Reasoning
Which of the following letter-number clusters will replace the
question mark (?) in the given series to make it logically complete?

GTG 6 HRI -12 IPK 24 JNM -48 ?

A.  MKI 98

B.  NHJ 78

C.  KLO 96

D.  NHY 65

✓

Q96 Reasoning
In a certain code language,
A @ B means ‘A is the father of B’
A & B means ‘A is the mother of B’
A # B means ‘A is the husband of B’
A % B means ‘A is the daughter of B’

Based on the above, how is P related to T if ‘P # Q % R & S @ T’?

A.  Wife’s brother

B.  Father’s father

C.  Mother’s father

D.  Father’s sister’s husband

✓

Q97 Reasoning
In a certain code language, ‘power heart tune’ is coded as 'qz wn ow'
and ‘tune kit theme’ is coded as ‘yc by wn’. How is ‘tune’ coded in the
given language?

A.  yc

B.  ow

C.  wn

D.  qz

✓

Q98 Reasoning
Read the given statement(s) and conclusions carefully. Assuming
that the information given in the statements is true, even if it
appears to be at variance with commonly known facts, decide which
of the given conclusions logically follow(s) from the statement(s).
Statement: All Carrots are Potatoes. No Potatoes are Tomatoes.
Conclusion I: No Tomatoes are Carrots
Conclusion II: Some Tomatoes are Carrots3954

A.  Only conclusion (I) follows

B.  Only conclusion (II) follows

C.  Neither conclusion (I) nor (II) follows

D.  Both conclusions (I) and (II) follow
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Q99 Reasoning
Based on the English alphabetical order, three of the following four
letter cluster pairs are alike in a certain way and thus form a group.
Which is the one that does not belong to that group? (Note: The odd
man out is not based on the number of consonants/vowels or their
position in the letter cluster)2841

A.  PO−RT

B.  NM−QP

C.  ON−RQ

D.  SR−VU

✓

Q100 Reasoning
Refer to the following letter series and answer the question
(Left) L K I J U N M H B Y V G T F C R Z D X (Right)
How many letters are there in the English alphabetical order
between the letter which is sixth from the left end and fourth from
the right end of the series?

A.  Five

B.  Three

C.  Four

D.  Six
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